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Vicon Workstation Quick Reference Guide

Introduction
This guide will familiarize the reader with how to collect human motion data with the Vicon
motion analysis system. This system consists both hardware and software components. The
hardware includes from 4 to 7 infrared MX cameras, an analog data acquisition module and an
optional CCD video camera. The software includes Vicon Workstation that collects and partly
processes the motion and analog data, the Eclipse database manager for keeping records of the
data files their associated calibration files and the programs BodyBuilder and Polygon from
constructing and processing the acquired data. Note that Visual3D, MatLab, BioProc3 can also
be used to view and analyze these data file. This guide will not include how to process the data
beyond the collection and reconstruction of the data into 3-D motion trajectories. Detailed
information about the Vicon system may be obtained from the online
Vicon manual or its hardcopy version.

Camera Setup
The first step to any motion capture session is decide on the number
MX cameras and their appropriate positioning within the laboratory.
Generally at least four cameras are necessary to obtain valid 3D motion
but as few as two is possible, for complex whole body motions six or
seven cameras may be needed. The cameras need to be aligned so that
each sees as much of the total motion as possible and that at least two
cameras can see all the markers throughout the duration of the analysis period of the motion
investigated. Note that at times a marker may be blocked from one or more camera’s view so
other cameras will be needed to see the marker during these periods. Furthermore, all cameras
will be to see the static calibration object (triangular plate with four markers, see Figure 4) so
that its position relative to the laboratory reference system may be
computed.

An optional “movie” camera for recording the subject and trial
conditions may positioned, usually, to view motion in the sagittal plane.
This camera is for presentation purposes and is not normally for
collection of analyzable data. We use a Basler charge-coupled device
(CCD) camera that collects digital images at the rate of 80 frames per
second or a Panasonic digital video camera at the rate of 30 Hz. Use the
Live Movie item in the System menu to align the movie camera

appropriately.
Start this step by turning on the

Vicon system and from the System menu pressing the System
Configuration... item to open an appropriate configuration file
such as, Gaitlab.car. Configuration files tell the system what
analog devices are available and how force platforms are aligned.
These files can only be selected at the beginning of the session. If
you pick the wrong one you may have to exit and restart
Workstation.  Next, select the Start Link item to have the Vicon
system search for the connected cameras and determine whether
the analog system is present (Figure 3). Finally, press the Eclipse
button (   ) and then use the Live Monitor item to position the Vicon
cameras optimally.

Figure 1. Vicon MX
infrared camera

Figure 2. Basler CCD
camera

Figure 3.  Searching for
cameras and analog system
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Subject Preparation and Marker Placement
The subject should wear the minimum amount of clothing and wear clothing that is skin tight if
possible and acceptable to the subject. Footwear should have no reflective material but if this is
not possible the reflective areas must be covered by nonreflective (cloth) tape.

The number and positioning of the markers is based on the type of motion being analyzed
and the number of body segments needed to answer the research question. Usually a whole lower
or extremity will be analyzed but sometimes the whole body will need to have appropriate
markers attached to specific anatomical landmarks. The default system used by the Vicon system
is called the Plug-In Gait marker set. This is similar to the Helen Hayes Marker system that was
designed for clinical gait analysis. Another well-used system is the Cleveland Clinic Marker set;
this set uses triads of markers attached as clusters to each segment analyzed. We prefer to use an
enhanced version of the Plug-In Gait marker set (see appendix 1). Our system includes
additional markers at the hip and medial aspects of the elbow, knee and ankle and additional foot
markers. We also use a different markers locations at the proximal ends of the pelvis and around
the head.

Note that, in general, each segment needs three noncollinear markers to identify the 3D
motion of a segment. These markers, called tracking markers, do not have to be located over
joint centres and in fact can be attached as triad clusters to the middle of a segment. The joint
centres, however, MUST be identified during a static recording of the total marker set. During
the static recording, the locations of both joint markers and tracking markers must be collected
and visible to the Vicon camera system. This step is critical to the valid analysis of the data. No
motion capture should be started until verification that all tracking markers and joint markers are
visible during the static trial (not the same as the static camera calibration).

Camera Calibration
Camera calibration requires two recordings. The first recording, the static
camera calibration, requires that the static calibration object (Figure 4) be
the only reflective object visible to all cameras. The subject and
calibration wand and any stray markers need to be covered or removed
from the laboratory briefly during this recording. Place this object at a
specific location on the floor of the laboratory and if using one or more
force platforms over a specific corner and in a specific direction of one of
the force platforms. Figure 5 shows the appropriate location for the static calibration object when
using force platforms.

Figure 4. Static
calibration object

Figure 5. Correct location of static
calibration object over force platforms
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Start this step by pressing the Calibrate Cameras... item in the System menu or the
calibration icon ( ). Press the Calibrate (Figure 6) button to record the location of the static
object on all cameras. Be sure the form shows the correct calibration object in the Reference

Object area. The correct Name of the wand is “2C) Ergocal 14mm mkr - 240mm Wand 14mm
mkr”. Press the Start button to record for a few seconds (Figure 7).

The second recording consists of moving a
specific wand (Figure 7) with three markers and of
a specific length. We use the intermediate sized
wand of the calibration set. Waft this wand slowly 
for between 1 to 2 minutes throughout the entire
volume to be calibrated moving the wand in with

three-dimensional motion. This procedure
may have to be done several times until a
suitable accuracy is achieved. Press the
Start button to record the wand’s trajectory
for several minutes. Afterwards the system
processes the calibration data and reports
on the accuracy and precision of the
calibrated volume. You should try to
achieve an accuracy (Mean Residual) of 
less than 1.000 mm and a static
reproducibility of less than 1.000% (Figure
8).

Figure 8.  Results of a camera calibration

Figure 6. Camera calibration screen. Check
the first seven boxes and select the correct
calibration object used.

Figure 7. 240 mm and 120 mm camera calibration
wands. Each has three reflective markers.
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Figure 10. Trial types and capture
options screen

Figure 9. Typical Eclipse database manager screen

Force Platform Calibration
Check that your force platform(s) are zeroed correctly. Use the Live Analog button (  ) in the
System menu. Check the Fz channels then press Update and Stacked to verify that the vertical
force channels are zeroed when the plates are in the Reset mode. Use Calibrate Analog Zero
Levels for System... in the System menu to accurately zero each force platform. Set the plates to
Operate before collecting any data. You should also have a person walk across the plates to
ensure that all the plates are feeding information to the analog system correctly.

Capturing Static and Movement Trajectories
Open the Eclipse database manager (Figure 9) and create a Project Name ( ) and associated
subdirectory. Next create new Subject ( ) and Session ( ) folders. Press the Trial icon ( ) to

begin a data collection trial. Press
the Types button and check the type
of data to be collected (Figure 10).
Check the Video data, Analog data and
optionally the Movie data boxes in the
Capture area. In the Open Windows
area, check the boxes labelled Video
Monitor, Analog Data  Movie Data and
3D Workspace  boxes. The first data
collected must be the subject
standing motionless with the arms
and legs in their neutral positions
and slightly abducted. Check the box
labelled Static trial then press OK.

Capture several static trials to ensure that you have a
complete view of all markers. It is advisable to reconstruct
and fully label one of these trials to make sure all markers
are visible and motionless for a brief period. You should
also check that the correct sampling rate, usually 200 Hz is
selected in the Sample Skip area.

Next, begin capturing of your motion trials. Be
sure to uncheck the box labelled Static trial in the Trial
Types form. It may be possible to reconstruct and label the
trials as they are collected. To minimize the duration that
the subject has to be in the lab you may skip these steps
until later.
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Reconstruction and Cropping
If the motion trials include the marker
trajectories from each camera. These are
2D views. The 3D positions are computed
by pressing the Reconstruct button of the
Trial menu. It may take time to fully
reconstruct the entire trial. Before labelling
the trajectories in the motion trials it is
advisable to crop unwanted data that are
outside the duration of the analysis or
outside the calibration volume. Use the 3D
view and its cursor to locate the start and
end of each trial. Move the upper markers
of the cursor bar (bottom of the form) to
mark the crop area (see Figure 12). Press
the Crop to Save Range in the File menu.
You should also select the Reload Analog
Data in the Trial menu to be sure that the
analog data is precisely synchronized with
the motion capture data.

Trajectory Identification and Gap Removal
To label the trajectories you should start with the static view of the subject and identify each
marker by clicking on a marker from the 3D view and then selecting its four letter name from the
list on the left of the screen (Figures 11 and 12). For speed you can click on a series of markers
and then selecting the markers names in the same order. As the markers are identified green lines
are added automatically to joint markers that are part of the same “rigid-body” or segment. Once
all markers have been identified you should check that all the trajectories are joined without any
gaps. Do this by sliding the cursor backwards and forwards within the trial. If a marker turns
white it needs to be manually labeled. Each label may have many trajectory paths.

To fill gaps press the Fill All Gaps item in the Edit menu. Next open each motion trial and
press the Autolabel item in the Trial menu to have the program label all the trajectories
automatically. As before check that all marker paths have been labelled and if not manually label
them. Next fill all the gaps and delete any unlabeled trajectories using the Delete Unlabeled
Trajectories item in the Edit menu. Lastly, save the trial data. You can now view and animate
your 3D trajectories and attach a model to the data points with the Visual3D program. Read the
document Visual3D Quick Reference Guide for information on this process.

Autolabelling
Once all paths have been labeled press the Create Autolabel Calibration... item in the Trial menu.
Save the labeled trial before proceeding further. To use the autolabel function with other trials go
to the Trial menu, select Options... and check the box that has the same name as the trial that was
used to perform the autolabel calibration (Figure 13). Next, press the Autolabel item from the
Trial menu. Usually the static trial is used to create the autolabel calibration.

Figure 11.  Example of unlabeled static trial  



6

Figure 12.  Fully labeled static trial. Right hand column show marker set labels. Items along
bottom control the animation and permit the insertion of event codes. The area above shows
locations of the event codes. The numbered area at the bottom includes a cursor for moving the
image to a particular frame number. The upper triangles mark the “crop region,” the lower
triangles mark the length of marker trails and the left and right sliders limit the animation region.

Figure 13.  Use the Trial Options menu to
enable autolabelling. Check the subject’s
name in the Subjects box and uncheck the
box: “Include subject names in labels”
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Appendix A

uOttawa Marker Set

 FORE

REAR   LEAR REAR

   LMEL
RMEL RMEL

RILC            LILC
RHIP RILC

RHIP

   LHIP

RMKN RMKN
   LMKN   

RMAN   LMAN RMAN
 
 RMT5

LMT5

RHAL      LHAL
RMT1 LMT1

Red      markers are additional for use by uOttawa Gait lab.

The following describes in detail where the markers should be placed on the subject. Where left
side markers only are listed, the positioning is identical for the right side. Markers defined in
grey are not normally used.
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Upper Body

Head Markers
LFHD Left front head Located approximately over the left temple
RFHD Right front head Located approximately over the right temple
LBHD Left back head Placed on the back of the head, roughly in a horizontal plane of

the front head markers
RBHD Right back head Placed on the back of the head, roughly in a horizontal plane of

the front head markers
FORE Forehead Middle anterior aspect of forehead 
LEAR Left ear Left ear canal
REAR Right ear Right ear canal
BHED Back of head Opposite of forehead marker

The markers over the temples define the origin, and the scale of the head. The rear markers
define its orientation. If they cannot be placed level with the front markers, and the head is level
in the static trial, tick the “Head Level” check box under options on “Run static model” in the
pipeline when processing the static trial. Many users buy a headband and permanently attach
markers to it.

Torso Markers
C7 7th Cervical vertebrae Spinous process of the 7th cervical vertebrae
T10 10th thoracic vertebrae Spinous Process of the 10th thoracic vertebrae
CLAV Clavicle Jugular notch where the clavicles meet the sternum
STRN Sternum Xiphoid process of the sternum
RBAK,
LBAK

Right back, Left back Place in the middle of the right scapula. This marker has no
symmetrical marker on the left side. This asymmetry helps
the autolabeling routine determine right from left on the
subject.

C7, T10, CLAV, STRN define a plane hence their lateral positioning is most important.

Arm Markers
LSHO Left shoulder Placed on the acromioclavicular joint 
LUPA Left upper arm

marker
Place on the upper arm between the elbow and shoulder
markers. Should be placed asymmetrically with RUPA

LLEL Left elbow Place on lateral epicondyle approximating elbow joint axis
LMEL Left medial elbow Place on medial epicondyle approximating elbow joint axis
LFRA Left forearm

marker
Place on the lower arm between the wrist and elbow markers.
Should be placed asymmetrically with RFRA

LWRA Left wrist marker A Left wrist bar thumb side
LWRB Left wrist marker B Left wrist bar pinkie side

The wrist markers are placed at the ends of a bar attached symmetrically with a wristband on the
posterior of the wrist, as close to the wrist joint center as possible.

LFIN Left fingers Actually placed on the dorsum of the hand just below the head of the
second metacarpal
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Lower Body

Pelvis
LASI Left ASIS Place directly over the left anterior superior iliac spine
RASI Right ASIS Place directly over the right anterior superior iliac spine

The above markers may need to be placed medially to the ASIS to get the marker to the correct
position due to the curvature of the abdomen. In some patients, especially those who are obese,
the markers either cannot be placed exactly anterior to the ASIS, or are invisible in this position
to cameras. In these cases, move each marker laterally by an equal amount, along the ASIS-ASIS
axis. The true inter-ASIS distance must then be recorded and entered on the subject parameters
form. These markers, together with the sacral marker or LPSI and RPSI markers, define the
pelvic axes.

LPSI Left PSIS Place directly over the left posterior superior iliac spine
RPSI Right PSIS Place directly over the right posterior superior iliac spine

LPSI and RPSI markers are placed on the slight bony prominences that can be felt immediately
below the dimples (sacroiliac joints), at the point where the spine joins the pelvis.

SACR Sacral wand
marker

Place on the skin mid-way between the posterior superior iliac spines
(PSIS). An alternative to LPSI and RPSI.

SACR may be used as an alternative to the LPSI and RPSI markers to overcome the problem
of losing visibility of the sacral marker (if this occurs), the standard marker kit contains a base
plate and selection of short “sticks” or “wands” to allow the marker to be extended away from
the body, if necessary. In this case, it must be positioned to lie in the plane formed by the ASIS
and PSIS points.

LILC Left iliac crest Place on the mid-superior aspect of the left iliac crest
RILC Right iliac crest Place on the mid-superior aspect of the right iliac crest

Use LILC and RILC as alternative to the above-mentioned pelvic markers. These markers
require right and left hip markers to fully define the pelvis.

Leg Markers
LKNE Left knee Place on the lateral epicondyle of the left knee
LMKN Left medial knee Place on the medial epicondyle of the left knee

To locate the “precise” point for the knee marker placement, passively flex and extend the knee a
little while watching the skin surface on the lateral aspect of the knee joint. Identify where knee
joint axis passes through the lateral side of the knee by finding the lateral skin surface that comes
closest to remaining fixed in the thigh. This landmark should also be the point about which the
lower leg appears to rotate. Mark this point with a pen. With an adult patient standing, this pen
mark should be about 1.5 cm above the joint line, mid-way between the front and back of the
joint. Attach the marker at this point.



10

LTHI Left thigh Place the marker over the lower lateral 1/3rd surface of the thigh, just
below the swing of the hand, although the height is not critical.

LHIP Left hip Superior aspect of greater trochanter

The thigh markers are used to calculate the knee flexion axis location and orientation. Place the
marker over the lower lateral 1/3rd surface of the thigh, just below the swing of the hand,
although the height is not critical. The anteroposterior placement of the marker is critical for
correct alignment of the knee flexion axis. Try to keep the thigh marker off the belly of the
muscle, but place the thigh marker at least two marker diameters proximal of the knee marker.
Adjust the position of the marker so that it is aligned in the plane that contains the hip and knee
joint centers and the knee flexion/extension axis. There is also another method that uses a mirror
to align this marker, allowing the operator to better judge the positioning. 

LLAN Left ankle Place on the lateral malleolus along an imaginary line that passes
through the transmalleolar axis

LMAN Left medial
ankle

Place on the medial malleolus

LTIB Left tibial wand
marker

Similar to the thigh markers, these are placed over the lower 1/3rd

of the shank to determine the alignment of the ankle flexion axis

The tibial marker should lie in the plane that contains the knee and ankle joint centers and the
ankle flexion/extension axis. In a normal subject the ankle joint axis, between the medial and
lateral malleoli, is externally rotated by between 5 and 15 degrees with respect to the knee
flexion axis. The placements of the shank markers should reflect this.

Foot Markers
LTOE Left toe Place over the second metatarsal head, on the mid-foot side of the

equinus break between forefoot and mid-foot
LHEE Left heel Place on the calcaneus at the same height above the plantar

surface of the foot as the toe marker
LHAL Left hallux Anterior surface of left hallux (big toe)
LMT1 Left metatarsal 1 Medial aspect of head of left metatarsal one
LMT5 Left metatarsal 5 Lateral aspect of head of left metatarsal five

Extra Markers
Wand1, ...
Wand4

Wand/Davi
s wand

Wand markers (Davis distal, proximal, far lateral,
near lateral)

Bat1, Bat 2,
BatR, BatL

Bat markers Bat/racquet/stick handle, middle, right or left end

Ball Ball marker Ball/puck/point marker
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Appendix B

Command Summary

1. System | System Configuration... then select the appropriate .car file.
2. System | Start Link to connect with cameras and analog system and set

camera frame rate (e.g., 200 fps).
3. System | Analog Setup to set sampling rate of analog system (e.g.,

200 Hz, 2000 Hz) and add/subtract additional analog channels (e.g., EMG
channels, accelerometers, etc.).

4. System | Force Plates Setup for System... to modify force platform
parameters and corners.

5. System | Calibrate Analog Zero Levels for System... to set zero
levels of force platforms and other analog signals. Reset the force platforms
and check the appropriate boxes before pressing Calibrate.

6. File | Open Database to open the Gaitlab or other database.
7. Open Eclipse (   ) and then open an existing project or create a new Project

Name ( ) and associated subdirectory. Next, create new Subject ( ) and
Session ( ) folders.

8. System | Calibrate Cameras... if the cameras were moved or need
recalibration.

9. Press the Trial icon ( ) to collect one or more static trials.
10. Before proceeding to the dynamic trials check that the all markers are visible

in the static trial. You can now save the autolabelling data (Trial | Create
Autolabel Calibration).

11. Press the Trial icon ( ) to collect dynamic trials. Check appropriate data
Types (e.g., Video, Movie, Analog) and Pipeline items (e.g., Reconstruction,
Labelling, Save Data, Next Trial).

12. After trials have been collected select trials from the database, complete
reconstruction, then mark the start and end of the data with the upper
markers in the 3D window. Then crop the data with the File | Crop to
Save Range item.

13. Use Trial | Options... to select the autolabelling trial then press Trial |
Autolabel to start the autolabelling procedure.

14. Edit | Defragment Trajectories to join marker trajectories.
15. Edit | Fill All Gaps to fill gaps in trajectories. For large gaps you may use

BodyBuilder to fill the gap. After using BodyBuilder you may need to
reattach the marker set with Trial | Attach Marker Set....

16. Edit | Erase Unlabelled Trajectories to remove any unlabelled
trajectories.

17. Lastly use File | Save to save the data.


